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SOLIDWORKS® 2022 Quick Start Overview of SOLIDWORKS® and the User Interface

Chapter 1
Overview of SOLIDWORKS® 2022 and the User Interface

ET————— ] AR R E 3D - © Bswserms o~ ® @ _ & X

_«_SOLIDWORKS Resources % -

SOLIDWORKS Resources ¢
Click to display this task pane tab. |24

2
DS SOLIDWORKS

Below are the desired outcomes and usage competencies based on the completion of
Chapter 1.

Desired Outcomes: Usage Competencies:

e A comprehensive e Ability to establish a SOLIDWORKS session.
understanding of the
SOLIDWORKS® User e Aptitude to utilize the following items: Menu
Interface (UI) and bar toolbar, Menu bar menu, Drop-down
CommandManager. menus, Context toolbars, Consolidated drop-

down toolbars, System feedback icons, Task
Pane, Confirmation Corner, Heads-up View
toolbar, Document Properties and more.

e Open a new and existing SOLIDWORKS part.

e Knowledge to zoom, rotate and maneuver a
three-button mouse in the SOLIDWORKS
Graphics window.
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Notes:
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Chapter 1 - Overview of SOLIDWORKS® 2022 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar and more.

On the completion of this chapter, you will be able to:

e Utilize the Welcome - SOLIDWORKS dialog box.

e Establish a SOLIDWORKS session.

e Comprehend the SOLIDWORKS User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three-button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

e This book is written for the beginner to intermediate user.
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Start a SOLIDWORKS Session

Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of
how to use the book and the structure. Actual input commands or required actions in the
chapter are displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http:/www.SOLIDWORKS.com.

Activity: Start a SOLIDWORKS Session.

Start a SOLIDWORKS session.

1) Type SOLIDWORKS 2022 in the Search window. ﬁ
L SOLIDWORKS 2022
2) Click the SOLIDWORKS 2022 application (or if available,

double-click the SOLIDWORKS icon on the desktop).
The Welcome - SOLIDWORKS dialog box is displayed by SW
default. Fl 2022

SOLIDWORKS
The Welcome - SOLIDWORKS box provides a £
convenient way to open recent documents (Parts, Assemblies and
Drawings), view recent folders, access SOLIDWORKS resources, and stay updated on
SOLIDWORKS news.

3) View your options. Do not open a document at this time.

A soupuonss  Fle view oo (B L ¥ - = -t - - £ - - @® @ _ F X
| << IDEXPERIENCE Marketplace:5 &
\ i)
Welcome - SOLIDWORKS * X ~ ]
~ ® QK
Home Recent Learn  Alerts VR
[Cear | D
3DEXPERIENCE™
New iyl
o Extend
& Pant 8 assembly  [BF Diawing Advanced. [ cpen = SOLIDWORKS with
E
the
Recent Documents view al 3DEXPERIENCE
. = Platform
LINKAGE-2 Assembly MowrandMotoriow,, SectionSLODRW Draw! SLODRW Dram 1 SLODRW E
4 | Connect to the
Ty M | 3DEXPERIENCE®
% latform and leverage
(. & - G ms o P o
) G -5 R - | T its collaboration, product
data and lfecycle
management, organic
< N shape design.
simulation solutions. and
Recent Folders Wiew all Resources | more. (Subscription
- i ~ | required.)
win . . .
I cizo2z souomonks Guid stortsoumaonks 2022 nsr. & what's New @ Customer Portal |
Use JDEXPERIENCE
Mech Integration Progress Report Nov 16 MySolidworks 4 User Graups
[ Cosersmtaniesiaops s 202217 7-202130gch By u " Marketplace (o source
Section 2 User Communities (@ Get Support | 3D content and services
D DA20: UDWORKS Quick Slar LWSOLIDWORKS 2022 Inslr, ~ worldwide. (ND license
@ A 2 model. Cirl + Arrow keys pan the model, &t 1 Arrow keys rosae the medel parallsl o the vizwing plars. < > | required.)

| EETENENRraem, -
EQUDWORKS Premium 2022 SPO.0 27

[ be net shewr

Let's get
started
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SOLIDWORKS® 2022 Quick Start

Home Tab

Overview of SOLIDWORKS® and the User Interface

The Home tab lets you open new and
existing documents, view recent
documents and folders, and access
SOLIDWORKS resources (Part,
Assembly, Drawing, Advanced mode,
Open).

Recent Tab

The Recent tab lets you view a
longer list of recent documents and
folders. Sections in the Recent tab
include Documents and Folders.

Welcome - SOLIDWORKS T X

Home Recent Learn  Alerts
T
New
[ I8 Assembly Drawing Advanced... A% open
Recent Documents View all
Assembly Modeling LINKAGE-2 Assembly. Motorandatorhtou Section SLDDRW Crawl SLDDRW
Sy IH
% | 1 —
R ® i e S T u B
@ ® g ) & £ 55 =D o
< >
Recent Folders View all Resources
Assembly Model 10-1 28 - .
i 12022 SOLIWORKS Tutorial\SW- TUTORIAL 2022 Instruct., @ What's New @ Customer Porlal

B MySolidWorks 8 User Groups

() english

CProgram Files\SOLIDWORKS Corp\SOLIDWORKS (4]\ang.

ﬁ Drawing ) User Communities I& Get Support
022022 SOLIDWORKS Quick StartSCLIDWORKS 2022 [nstr., hd

~
’iv" Arow keys rotate the madel, Cirl + Amow keys pan the model, At = Arrow keys rotste the model parallel to the viewing plane,

The Documents section includes

thumbnails of documents that you

have opened recently. eemeSOUBHORES -

) . Home Rﬂ;&n_t Learn Alerts
Click a thumbnail to open the Documents  Folder reeresm—
document, or hover over a cuiktier % [ 58] 58] [Fieerbroame P
thumbnail to see the document T rryeen W el — P -
location and access additional f ‘*-ﬁ% b [ '
information about the document. @ I § = T = s
When you hover over a

thumbnail, the full path and last saved
date of the document appears.

Learn Tab

The Learn tab lets you access
instructional resources to help you learn
more about the SOLIDWORKS
software.

Sections in the Learn tab include:

e Introducing SOLIDWORKS.
Open the Introducing
SOLIDWORKS book.

[ ]

[ ]

[ ]

[ ]
solidworks.com.

[ ]

Welcame - SOLIDWORKS

Home  Recent Lenqn  Alerts

Introducing SOLIDWORKS

Tutorials

MySalidWorks Training

LIDWy * Unlim

Samples
Introducing SOLI... Tuterials
Samples Samples MySolidWarks
3 a & a: o % CAD Models
@ oOnline Tuterials & My Training R Certification B Curriculum

Tutorials. Open the step-by-step tutorials in the SOLIDWORKS software.
MySolidWorks Training. Open the Training section at MySolidWorks.com.
Introducing SOLIDWORKS (Samples). Open local folders containing sample models.
Tutorials (Samples). Open the SOLIDWORKS Tutorials (videos) section at

What’s New (Samples). List of new changes.
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¢ Online Tutorials.
e My Training. Open the My Training section at MySolidWorks.com.

e Certification. Open the SOLIDWORKS Certification Program section at
solidworks.com. You will need to create an account with a password.

e Curriculum. Open the Curriculum section at solidworks.com. You will need to create an
account with a password.

e MySOLIDWORKS - CAD Models. Open models in the Community Library. You will
need to create an account with a password.
s s

“¥* When you install the software, if you do not install the Help Files or Example Files, the
Tutorials and Samples links are

unavailable' ‘Welcome - SOLIDWORKS g X
Home Recent Learn Alerts Lrngn
Alerts Tab Troubleshogtin Technical AT
T
The Alerts tab keeps you updated
with SOLIDWORKS news.

Sections in the Alerts tab include
Critical, Troubleshooting, and
Technical.

R

“¥" The Critical section does not
appear if there are no critical alerts to display.

e Troubleshooting.
Includes troubleshooting
messages and recovered e
documents that used to [ Rt
be on the
SOLIDWORKS
Recovery tab in the
Task Pane.

Welcome - SOLIDWORKS 2 X

R

:Q: If the software has a @

technical problem and an
associated troubleshooting
message exists, the Welcome dialog box opens to the Troubleshooting section automatically
on startup, even if you selected Do not show at startup in the dialog box.

e Technical Alerts. Open the contents of the SOLIDWORKS Support Bulletins RSS feed
(Hotfixes, release news) at solidworks.com.
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Close the Welcome - SOLIDWORKS dialog box.

4) Click Close * from the Welcome - SOLIDWORKS dialog box. The
SOLIDWORKS Graphics window is displayed. You can also click outside Close
the Welcome - SOLIDWORKS dialog box, in the Graphics window.

View the SOLIDWORKS Graphics window.

| souwores e view Toots # fay L) ¥ L= E -2 [ - @ Bedoms o @ @ _ O X
Ll

ol

@

]

2

2,

DS SOLIDWORKS o

2022

Menu Bar toolbar

The SOLIDWORKS (UI) D%SOUDWORKS File View Tools ﬁ D - @ = -
is designed to make

maximum use of the

Graphics window. The @ il % ) {(?? ) Search Commands  Q ~
Menu Bar toolbar contains a

set of the most frequently

used tool buttons from the Standard toolbar. @ @ = X

The following default tools are available:

e  Welcome to SOLIDWORKS ) - Open the Welcome dialog box, New - Create a
new document; Open arg8 Open an existing document; Save @i - Save an active

document; Print =1 Print an active document; Undo 2 - Reverse the last action;

Redo (ol Redoes the last action that you reverse; Select % " - Select Sketch entities,

components and more; Rebuild @ - Rebuild the active part, assembly or drawing;

File Properties == - Summary information on the active document;
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Options i Change system options and Add-Ins for SOLIDWORKS; Login ®.

Login to SOLIDWORKS. You will need to create an account with a password; Help @
- access to help, tutorials, updates and more.

Menu Bar menu (No model open) S
DS SOLIDWORKS ~ File View Tools *

SOLIDWORKS provides a context-sensitive menu

structure. The menu titles remain the same for all

three types of

documents, (Parts, & souvwores  Fieview Tools ¢ £ ) PR -L]-= -0 -0 - 6% -
. [

Assemblies and

Drawings) but the menu items change depending on which type of document is active.

Menu Bar menu (Model open)

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

DDSSOLIDWORKS File Edit View Insert|Tools Window ﬁv ﬁ - B? - - g - - - I} M {é}
Drop-down menu (Open part document) E; Edit View Isert Tools Window # 4]
New... Ctrl+N
SOLIDWORKS takes advantage of the familiar Microsoft®  |* gpe”"r'{ t SRS
Windows user interface. Communicate with SOLIDWORKS Ozen Drawing
through drop-down menus, Context sensitive toolbars, I Close Ctrl+W
Consolidated toolbars or the CommandManager tabs. $ Make Drawing from Part
[f ake Assem rom Fa
To close a SOLIDWORKS drop-down menu, press the Esc ERake Ao aTeer
key. You can also click any other part of the SOLIDWORKS save curl+S
Graphics window or click another drop-down menu. [ ::: 2;'"
Page Setup...
@ Print Preview...
& Print.. Ctrl+P
(& Print3D..

9@ Publish to eDrawings

@ Pack and Go...
Send To...

Find References...
Properties...

Exit

Customize Menu
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Create a New Part Document

Activity: Create a new Part Document.

A part is a 3D model, which consists of features. What are features? Features are geometry
building blocks. Most features either add or remove material. Some features do not affect
material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles or from edges and faces of
existing geometry.

Features are individual shapes that combined with other features make up a part or assembly.
Some features, such as bosses and cuts, originate as sketches. Other features, such as shells
and fillets, modify a feature's geometry.

Features are displayed in the FeatureManager.
¥ The first sketch of a part is called the Base Sketch. The Base sketch is the foundation for
the 3D model. The book focuses on 2D sketches and 3D features.

w1
“¥" FeatureManager, CommandManager, and tree folders will vary depending on system
setup, version, and Add-ins.

DjSSOL.'DWORKS File Edit View Insert Tools Window ﬁ D - @ - - T - @ @ — D X
@ g fSwept Boss/Base né @ ﬁ Swept Cut EE @ Rib Wrap .ii] U

Extruded Revolved i Lofted Boss/Base Extruded I—!ole Revolved m Lofted Cut Fillet Linear BDraf‘t [@ [ Reference Curves
Boss/Base Boss/Base Cut Wizard Cut Pattern Geometry

Boundary Boss/Base @ Boundary Cut . . @ Shell ilc:] Mirror B . A

Features ‘ Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins D E ﬂ X

PLEPER © B D

% Bracket (Default<<Defaul -
» [@lHistory Part FeatureManager

[%] Sensors
» [A] Annotations

+ (@] Solid Bodies(1)
&= Equations

55 Material <not specified>

[ Front Plane
[ Top Plane
[ Right Plane

s |C NI

I_,Origin

&) Extrude-Thin1 Y

@ Fillet1
@ @5.0 (5) Diameter Hole1 2 ”

£% LPattern1 w
< > | *Isometric

IADTT Model = Motion Study 1 |
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There are two modes in the New
SOLIDWORKS Document dialog
box: Novice and Advanced. The
Novice option is the default option
with three templates. The
Advanced mode contains access to
additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Create a new part.

5) Click New from the Menu
bar. The New SOLIDWORKS
Document dialog box is
displayed.

Select the Advanced mode.

6) If needed, click the Advanced
tab. The below New
SOLIDWORKS Document box
is displayed.

7) Click the Templates tab.
8) Click Part. Part is the default
template from the New

SOLIDWORKS Document
dialog box.

9) Click OK from the New
SOLIDWORKS Document
dialog box.

The Advanced mode remains

SOLIDWORKS® 2022 Quick Start

New SOLIDWORKS Document

a @€

Part Assembly

a 3D representation of a single design

component assemblies

Novice mode

AdvanceE

a 3D arrangement of parts and/or other  a 2D eng

g

g5

Drawing

ineering drawing, typically of a
part or assembly

oK Cancel Help

New SOLIDWORKS Document

Templates MBD

AN

@ Assembly
Ea Drawing

Tutorial

Advanced mode

Novice

SIS

Preview

OK Cancel Help

selected for all new documents in the current SOLIDWORKS session. When you exit
SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, MBD, and Tutorial. The Templates tab corresponds to the
default SOLIDWORKS templates. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition). The Tutorial tab corresponds to the templates
utilized in the SOLIDWORKS Tutorials.
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Partl is displayed in the FeatureManager and is the name of the document. Partl is the default
part window name.

The Part Origin ’L is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The
FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

w1

N A Y . . MKS (meter, kilogram, second
“¥* Edit the document units directly from the Graphics window {(meter, kilogram, second)

. CGS (centimeter, gram, second)

as illustrated. MMGS (millimeter, gram, second)
Wl [ IPS (inch, pound, second)

“¥* CommandManager, FeatureManager tabs will vary Edit Document Units...

Editing Part PS ;&

depending on system setup, version, and Add-ins.

/ Main menu toolbar
2 / [
ZS SOLIDWORKS File Edit View Insert Tools Window * @ D - @ - - - % - " P @ @ _— D X

@ L
a I TN
Extruded Revolved Reference Curves |Instant3D
Boss/Base Boss/Base Geometry

~

Features | Sketch | Evaluate MBDDimensions‘ SOLID\VNORKSAdd—Ins ) ) V ZI 'E _ [-_H_H X
== S PLGPEC > SR

SEEE S~

g

CommandManager
& Part1 (Default) <<

[@History
[@ sensors Default Part FeatureManager Task Pane
» [A]Annotations

= Equations
$% Material <not speci ;L_
[ Front Plane h

[J Top Plane Hide/Show \ Origin

L Right Plane FeatureManager tab
I_,Origin

Heads-up View Toolbar

meECen e

M Triad
/

<. > | *Trimetric
Model | Motion Study 1

souowogs Premium 202?0 giting Part / ws/@

Model Mode  Motion Mode Activity Units Tag
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View the Default Sketch Planes.

10)
11)
12)
13)

Click the Front Plane from the FeatureManager.
Click the Top Plane from the FeatureManager.

Click the Right Plane from the FeatureManager.

Right Planes. The Origin point is displayed.

14) Click inside the Graphics window.

SOLIDWORKS® 2022 Quick Start

Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and

2
DS SOLIDWORKS  File Edit View Insert Tools Window X

Extruded Revolved
Boss/Base Bass/Base

SOUDWORKS Add-Ins

Features Sketch Evaluate MBO Dimensions

SE RS @R

& Pan1 (Default< <Default>_Displ
[BlHistory

Fronts
Qneg

= > "Trimetric

0P E 89

P™e= oo _ o x
Re;f—me Cuzrv{s \ns;'?nn;D
PLRep@ v e e 00 -3 x
Ll
B
Rl
— =
’E
e
B=

‘\

WSS Model | Motion Study 1 |
art]

Editing Part

¥
3

Download the SOLIDWORKS-MODELS 2022 folder from the SDC Publication website
(https://www.sdcpublications.com/downloads/978-1-63057-478-9). Open the

Bracket part. Review the features and sketches in the Bracket FeatureManager.

Work directly from a local hard drive.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.

Download the SOLIDWORKS-MODELS 2022 folder.
Unzip the folder. Work from the unzip folder.

15)
16)

o
Click Open U from the Menu bar menu.

Browse to the SOLIDWORKS-MODELS-2022\Bracket
folder.

17)
18)

19) Double-click the Bracket part. The Bracket part is displayed

in the Graphics window.

PAGE 1-12
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75 SOLIDWORKS  File Edit View Insert Tools Window # ﬁ M @ M - Q N N ' @ @ - O X
@ 3 fSwept Boss/Base Dé @ ﬁ Swept Cut @ EE @ Rib Wrap .Eii U h\ljj
srovdd toroed B ot 0l 10000 (ot 1 00 [ vt 0 s e s [ERIGR
@ Boundary Boss/Base . @ Boundary Cut . . @ Shell F|CE| Mirror . . A
Features | Sketch ‘ Evaluate MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ p @ @ @ . a . @\ . % & - |:| . [I |] _ ﬂ X

ERo S
g

@5 Bracket (Default fault>_Disy
» @l History
Sensors

» [&] Annotations \

191 Sold Bociest) Part FeatureManager
Equations

55 Material <not specified>
LJ Front Plane

{7 Top Plane -
1l Right Plane J

\

(4
e e

L, origin /‘ . 8=
4 @ Extrude-Thin1
B Fillet1

%

y
6. "

é

(7

é

& 5.0 (5) Diameter Hole1
EE LPattern1

[ 210.0 (10) Diameter Hole1
EE LPattern2

Cut-Extrude1

EE LPattern3

< 2 | *Isometric

- Model | Motion Study 1 |

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

20) Place the mouse pointer over the rollback bar in the FeatureManager design tree as illustrated.

The pointer changes to a hand 1. Note the provided information on the feature. This is called
Dynamic Reference Visualization.

» @] Extrude-Thin1

B Fillet1

» @ Extrude-Thin1

® Fillet1

» [ @5.0 (5) Diameter Hole1

21) Drag the rollback bar up the FeatureManager
design tree until it is above the features you v [&@5.0 (5) Diameter Holet
want rolled back, in this case 10.0 (10) BE Lpatternt £E Lpatter
Diameter Hole1. — Dia}neet—eleeW » [&210.0 (10) Diameter Hole1

B
EE LPattern2 e
> Cut-Extrude1
» & Cut-Extrudet Bl
e LPattern3

EE LPattern3 ﬁF

22) Release the mouse button.
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View the first feature in the Bracket Part.

23) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics
window. This is a great feature to re-engineer a part.

S SOLIDWORKS  File Edit View Insert Tools Window # @ - |2'7 o © © Q M " . @ @ - O X
@ 3 rSwept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap .ﬂ U

Extruded Revolved Extruded Hole Revolved Fillet Linear Reference Curves
Boss/Base Boss/Base ‘ Efied Bos/Bess Cut  Wizard  Cut @ LofiediCut Pattern E Dhaty @ Bter=ct Geometry

@ Boundary Boss/Base @ Boundary Cut . @ Shell H'ﬂ Mirror

Features [Sketch] Evaluate ‘ MBD Dimensions ‘ SOLID;VORKS Add-Ins ‘ p @ @ . a . Q\ . % &; . G .
?% BRo@®

@ Bracket (Default< <Default>_Disy
> [@History
[E@ sensors
> [&) Annotations
> [@Solid Bodies(1)
[E)Equations
33 Material <not specified>
(J Front Plane
(7 Top Plane
() Right Plane
1, origin
4 ﬂEnrude—Thim
= Fillet1
» [325.0 (5) Diameter Hole1

"

Y

LPattern1

» [3@10.0 (10) Diameter Hole1
£ LPattern2

» (& Cut-Extrudel

UC LPattern3
Y

A

< > | *Isometric
T Model | Motion Study 1 |

Return to the original Bracket Part
FeatureManager.

24) Right-click Extrude-Thin1 in the
FeatureManager. The Pop-up
Context toolbar is displayed.

25) Click Roll to End. View the

[&]sensors A
.
Annotc@ @ 1® «

Marku

— x =
[®lSolid '@“T’ @ :
Equati(Feature (Extrude-Thin1)

-

-

-

Omm . .
results in the Graphics window. e Materi Roll to Previous

[J Front F‘ Rpll to End

J Top PI CL)\%Iment ’

[V Right F Parent/Child...

rigin % Configure Feature
’ @Extrud X Delete..

® Fillet1 Add to Favorites
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- i = O
Heads-up View toolbar p@@@@\%&g
SOLIDWORKS provides the user with
numerous view options. One of the most useful tools is the Heads-up View toolbar displayed

in the Graphics window when a document is active.

w1

Bs Dynamic Annotation Views & : Only available with SOLIDWORKS MBD (Model
Based Definition). Provides the ability to control how annotations are displayed when you
rotate models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

26) Click the Zoom to Fit ”’@ icon. The tool fits the model to the
Graphics window.

N

Zoom to Area on the model in the Graphics window.

F fa
27) Clickthe Zoomto Area ¢ icon. The Zoom to Area
icon is displayed.

Zoom in on the top left hole.

28) Window-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.

F
29) Click the Zoomto Area < icon.

Fit the model to the Graphics window.

30) Press the f key 75 S0LIDWORKS  File Edit View Insert Tools Window # R} - 8- K-8 ® ® - O x
A D Jswertvossmase B W (8 swercn @ !:E dro g @
Rotate the model. e somiose & oteatosyeme G For, o ([ onecu P10 ot (D et (200
@ Boundary Boss/Base: . @eoundarycur (W shen BIminor : } ~
31) Hold the middle Features Sketch Evaluate = MBD Dimensions \ SOLIDWORKS Add-Ins p @@ @ @ . @ %ﬁ . |;| D E @ X
mouse button down. |SER¢@F
v @
Drag upward b, § t:::u:;)efaul«<Defaun>_nis. ﬁ
Sensors. @
downward U tothe | Zime =1
left U and to the right
[J Top Plane
U to rotate the model | ;=
in the Graphics G
W|nd0W > gﬁzigflamm Hole1
» 32100 (10) Diameter Hole1 T
+ B e
£% LPattem3
A\,
ST Model | Motion Study 1
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Display a few Standard Views.

32) Click inside the Graphics window.

33) Click Front from the drop-down Heads-up
view toolbar. The model is displayed in the Front
view.

Click Right (i from the drop-down Heads-up
view toolbar. The model is displayed in the Right
view.

34)

Click Top = from the drop-down Heads-up
view toolbar. The model is displayed in the Top
view.

35)

Display a Trimetric view of the Bracket model.

36) Click Trimetric @ from the drop-down Heads-
up view toolbar as illustrated. Note your options.
View the results in the Graphics window.

SOLIDWORKS Help

SOLIDWORKS® 2022 Quick Start

FPUEAPEAET © R O
>e
é@ -
(=
1
Ve
= nE
FIEPEAEIv » Ol o-

Help in SOLIDWORKS is context-sensitive and in HTML format. Help is accessed in many

ways, including Help buttons in all dialog boxes and PropertyManager and Help @ on the

Standard toolbar for SOLIDWORKS Help.

P
DS SOLIDWORKS File Edit View Insert Tools Window #

A D Fovervosne

Ertruded Revoved g
Lofted Boss/B
Boss/Base Boss/Base s
@ Boundary Boss/Base

Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins

%% BER¢@®

@) Bracket (Default< <Default>_Disy
» @ History
[ sensors
» [&)Annotations
» [@Solid Bodies(1)
[ Equations
% Material <not specified>
[7) Front Plane

Cut  Wizard Cut

Features

() Top Plane
[} Right Plane
L, origin

» @) Extrude-Thin1
BFillet1

» [3@5.0 (5) Diameter Hole1
8E Lpatternt

» [3@10.0 (10) Diameter Hole1
£E LPattern2

> [B Cut-Extrudet

£2 LPattern3 .

P

> *Trimetric

<
S Model | Motion Study 1

0
@ @ ﬁswep(cu(

Extruded Hole Revolved m Lofted Cut

PE-am

@ Boundary Cut

N9
B8R A @ d P

Fillet Linear Reference Curves |Instant3D|
Draft Intersect
Pattern eometry

. (Wshen BfIMior ~
PLEHE O @SR T 0D - & X
@

)

®

=

e
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37) Click @ from the Standard toolbar. hodels Q- (@) q% _ 5 X
38) Click @ Help from the drop-down menu. The -
SOLIDWORKS Home Page is displayed by default. Help
View your options. SOLIDWORKS CAM
Tutorials
1: ":— ' ' APl Help
SOLIDWORKS Web Help is active by default Use Web Help
under Help in the Main menu. User Communities

Search

Release Notes

Close Help. Return to the SOLIDWORKS Graphics window. What's New

@ duci d
39) Close Ed SOLIDWORKS Home. (ificeelreliy SOLRIERE (7l
Moving from 2D to 3D

. SOLIDWORKS Rx

SOLI DWORKS Tutorials Check for Updates...

Display and explore the SOLIDWORKS tutorials. E:Z::eipon

40) Click @ from the Standard toolbar. My Products..

About SOLIDWORKS...

41) Click Tutorials. The SOLIDWORKS Tutorials are ‘
displayed. The SOLIDWORKS Tutorials are 2 SOLIDWORKS Tutorials - o

presented by category.

42) Click the Getting Started category. The Getting
Started category provides lessons on parts,
assemblies, and drawings. | N

Advanced Tethniques Productivity Tools

Rl & 8
Show Back Print

SOLIDWORKS Tutorials: Getting Started

Getting Started Basic Techniques

In the next section, close all models, tutorials and Design Evaluation ~ CSWP/CSWA Preparation
view the additional User Interface tools.

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.
43) Close Ed SOLIDWORKS Tutorials.

. ™ )
44) Click Window, Close All from the Menu bar menu. erydxow * ﬁ D

Viewport

User Interface Tools
| "= New Window

The book utilizes additional areas of the
SOLIDWORKS User Interface. Explore an overview
of these tools in the next section.

Cascade
B Tile Horizontally
L[] Tile Vertically
; Arrange Icons
Close All

Vi

1 Part1 *

2 Bracket *

Browse Open Documents...

Customize Menu
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Right-click ’ GRS

il in " FC=PLBO
ng t-click m the Grap ‘ICS Zoom to Fit Select Tangency
window on a model, or in the 53 7g0m to Area selection Tools
FeatureManager on a feature or 1% Zoom In/Out Zoom/Pan/Rotate
sketch to display the Context- C  Rott 7V' Recent Commands
sensitive toolbar. If you are in the & rotate view Face
middle of a command, this toolbar I & Change Transparency

. R . @ Roll View @  Create Plane Parallel to Scree
dlsplays a hSt Of OptIOHS ) Feature (Extrude-Thin1)
specifically related to that Refiits A0 S s i Comment
command. Set Current View As... Parent/Child...

. . . &’ View Orientation... [%  Configure Feature
Right-click an empty space in the _ X Delete...
Graphics window of a part or @ Edit Scene Add to Favorites
assembly, and a selection context ~ [= Open Drawing Save Selection
toolbar above the shortcut menu is Recent Commands ' B°dy| "

. . . solate
displayed. This provides easy Contow_ Select Tool Export to DXF / DWG
access to the most commonly used Customize Menu FeatureWorks...
selection tools. Find Similar in PartSupply

Consolidated toolbar

Similar commands are grouped together in the e
CommandManager. For example, variations of the Rectangle / @ J-i
sketch tool are grouped in a single fly-out button as illustrated. O @ A g
If you select the Consolidated toolbar button without expanding: = Cemer ficzmgle

=1 Center Rectangle
For some commands such as Sketch, the most commonly used ' 3 Point Comer Rectangle
command is performed. This command is the first listed and the | & 3 point Center Rectangle
command shown on the button. [ Parallelogram

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when
the Consolidated toolbar is expanded.

System feedback icon N

SOLIDWORKS provides system feedback by attaching a
symbol to the mouse pointer cursor.

al P Re] [5,]

Face - Edge'Dimension- - Vertexq|

The system feedback symbol indicates
what you are selecting or what the
system is expecting you to select.

As you move the mouse pointer across
your model, system feedback is
displayed in the form of a symbol,
riding next to the cursor as illustrated.
This is a valuable feature in SOLIDWORKS.
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Confirmation Corner

When numerous SOLIDWORKS commands are active, a symbol
or a set of symbols is displayed in the upper right-hand corner of the
Graphics window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second
symbol is a large red X. These two symbols supply a visual
reminder that you are in an active sketch. Click the sketch symbol
icon to exit the sketch and to save any changes that you made.

When other commands are active, the confirmation corner box
provides a green check mark and a large red X. Use the green check
mark to execute the current command. Use the large red X to cancel
the command.

w1
- s

Overview of SOLIDWORKS® and the User Interface

[]

5

X

Confirm changes you make in sketches and tools by using the D keyboard
shortcut to move the OK and Cancel buttons to the pointer location in the

Graphics window.

Heads-up View toolbar
SOLIDWORKS provides the user

with numerous view options from
the Standard Views, View and

Standard Views

Heads-up View toolbar. > ‘ W @ &
The Heads-up View toolbar is a View B
transparent toolbar that is displayed @2‘ Al ¢ @ -@2m -

in the Graphics window when a

document is active. J& &j A VR g -®- % @ e

You can hide, move or modify the
Heads-up View toolbar. To modify

PREGCHR. ©-Q
A N

the Heads-up View toolbar, right-
click on a tool and select or deselect

~

the tools that you want to display. For a drawing document

The following views are available.
Note: available views are document dependent.

e Zoom to Fit ¢ : Fit the model to the Graphics window.

e Zoom to Area OQ : Zoom to the areas you select with a bounding box.

P
e Previous View ¥ : Display the previous view.
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SOLIDWORKS® 2022 Quick Start

o Section View @:Displayacutawayofa Q@@@@\%ﬁg
# f

part or assembly, using one or more
cross section planes.

Control how annotations are displayed
when you rotate a model.

View Selector (Ctrl+SpaceBar)

° Dynaml‘c Annotation Views g}g : Only Show or hide the in-context View Selector to choose

. . from a variety of standard and non-standard view
available with SOLIDWORKS MBD. orientations. Press Alt to expose only the back faces of ’.T>

the View Selector.

The Orientation dialog has an option to
display a view cube (in-context View
Selector) with a live model preview. This
helps the user to understand how each
standard view orientates the model. With the

view cube, you can access additional standard views. The

views are easy to understand and they can be accessed
simply by selecting a face on the cube.

To activate the Orientation dialog box, press (Ctrl +

spacebar) or click the View Orientation ® icon from

the Heads-up View toolbar. The active model is displayed
in the View Selector in an Isometric orientation (default

view).

Click the View Selector icon in the Orientation dialog
box to show or hide the in-context View Selector.

w1

“¥" Press Ctrl + spacebar to activate the View
Selector.

w1

2 Press the spacebar to activate the Orientation
dialog box.

e View Orientation box & “: Select a view
orientation or the number of viewports. The
options are: Top, Left, Front, Right, Back,
Bottom, Single view, Two view - Horizontal,
Two view - Vertical, Four view. Click the drop-
down arrow to access Axonometric views:
Isometric, Dimetric and Trimetric.

e Display Style W ": Display the style for the
active view. The options are: Wireframe,
Hidden Lines Visible, Hidden Lines Removed,
Shaded, Shaded With Edges.
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SOLIDWORKS® 2022 Quick Start Overview of SOLIDWORKS® and the User Interface

o Hide/Show Items ® " Select items to hide or show in the Graphics
window. The available items are document dependent. Note the View

Center of Mass ¥ icon.

e
9
#
0

\0
N

\.
\o
~

\0

Qe

e [Edit Appearance @ : Edit the appearance of entities of the model.

o Apply Scene 2 : Apply a scene to an active part or assembly
document. View the available options.

o JView Setting:I “: Select the following settings: RealView Graphics,
Shadows In Shaded Mode, Ambient Occlusion, Perspective and
Cartoon.

p
e Rotate view C : Rotate a drawing view. Input Drawing view angle
and select the ability to update and rotate center marks with view.

il @ H - DReC) T e

e 3D Drawing View %% : Dynamically manipulate the drawing view in
3D to make a selection.

S F
@5 % ¢ 2 W@ <=0

To display a grid for a part, click Options G- , Document Properties tab.
Click Grid/Snaps, check the Display grid box.

w1

“¥* Add a custom view to the Heads-up View

N B

toolbar. Press the space key. The Orientation dialog g vReaMQW —
&
box is displayed. Click the New View & tool. The v shadows n shaded Mode
Name View dialog box is displayed. Enter a new ® Ambient Ocuson
. . % Perspective
named view. Click OK. © coroon

Use commands to display information about the triad —
or to change the position and orientation of the triad. |~ L - \ﬁ%
AT

]

Available commands depend on the triad's context. Options
| Changes options settings for
3 SOLIDWORKS.

“¥* Save space in the CommandManager, limit
your CommandManager tabs. Right-click on a E";TZ{S:’;‘S::;’?&::?:; ’
CommandManager tab. Click Tabs. View your e &1 Features
options to display CommandManager tabs. foolbars " [ Sketch

Customize... Sketch Ink

Surfaces
Sheet Metal
Structure System
Weldments
Mold Tools
Mesh Modeling
Data Migration
Direct Editing
Markup
Evaluate
MBD Dimensions

Render Tools
SOLIDWORKS Add-Ins
Analysis Preparation
SOLIDWORKS CAM
SOLIDWORKS CAM TBM

PAGE 1-21



Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2022 Quick Start

SOLIDWORKS CommandManager

The SOLIDWORKS CommandManager is a Context-sensitive toolbar. By default, it has
toolbars embedded in it based on your active document type. When you click a tab below the
CommandManager, it updates to display that toolbar. For example, if you click the Sketch tab,
the Sketch toolbar is displayed.

" For commercial users, SOLIDWORKS Model Based Definition (MBD) and
SOLIDWORKS CAM is a separate application. For education users, SOLIDWORKS MBD
and SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

S
-

Below is an illustrated CommandManager for a Part document. Tabs will vary depending on
system setup and Add-ins.

ﬁ g JaSwept Boss/Base

Extruded Revolved i o) BB
Boss/Base Boss/Base

Dé @ @ Swept Cut

Extruded Hole Revolved mLofted Cut
Cut Wizard Cut

@ Boundary Cut

Features | Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins

@ 4 @ Rib Wrap
Fillet Linear %Draft [@ Intersect

Pattern

. @ Shell F‘ED Mirror

[ 3
Y Q
Reference Curves Instant3D)
Geometry

YPT T

Boundary Boss/Base

1

Q <\ / N @ e [U = % @ C l}li'{l Mirror Entities I l .F ; @

Exit .Smar‘t E . 0 . @ . A Irfn;\ Con.v_ert Offs.et EE Linear Sketch Pattern = Dlsplay/.DeIete Repair Rapid |Instant2D

Sketch|Dimension e Entities Entities Entities Relations  Sketch Sketch

= . 2 @ I - @ . . 20 Move Entities - . .

Features ‘ Sketch ‘ Markup ‘ Evaluate | MBD Dimensions ‘ SOLIDWORKS Add-Ins @ O Kﬁ @ 2 fﬁ E
Fs On ﬁ ¥ £ @ &G & (2 check X Deviation Analysis. ) Draft Analysis A symmetry check @f; o)
Desian Inerfrence Measure Matup Mass  Secton Senor Perormance (1) eometry Al N zebrasvives [ Undercut nalysis S5 hickness Anaysis Sk pinssioeiyy

: CuNalure @Paning Line Analysis D;_.}]cOmpave Documents Document
Features[sketctharkup Evaluate | MBD Dlmenslons: SOLIDWORKS Add-Ins /@D g@ﬁﬁ?@ ﬁﬂ D) MD

XXX XXX
& &= B = g @ 20
Auto Location Size Basic  Pattern Datum Geometric
Dimension Dimension Dimension Location Feature Tolerance
Scheme Dimension
Features ‘ Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins
@ g = [
w @ % & T ¥ <

CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS SOLIDWORKS

360 Motion Routing Simulation Toolbox Flow Plastics
Simulation
Features | Sketch | Markup | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins |

w e {@} 'Fk

“¥* Set button size from the Toolbars tab of the Customize i |
dialog box. To facilitate element selection on touch interfaces ‘% Options
such as tablets, you can set up the larger Size buttons and text Customize...
from the Options menu (Standard toolbar). Add-Ins...

Save/Restore Settings...
B Button Size
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it
based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for a Drawing document. Tabs will vary
depending on system setup and Add-ins.

T
i D “ m i===)
L, @ GBE DB
D [ “ .3'0 @ D=h E =] ﬁ
Model Projected Auxiliary Section Removed Detail Relative Standard Broken-out Break Crop Alternate Empty Predefined Replace
View  View View  View Section View View 3View Section View View Position View View Model
View
Drawing | View Layout | Annotation ‘ Sketch‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format =—
i) o B “ =2
@ g & 3 @Q 5o L& (5
Standard Model Projected Auxiliary Section Removed Detail Broken-out Break Crop Alternate
3View View View View = View Section View Section View View Position
View
Drawing ‘ View Layout ‘ Annotation ‘ Sketch = Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format
<\ é& Ahé i A m @Balloon V/_Surface Finish [2[03]Geometric Tolerance '@'Center Mark @
Smart  Model Spell Format Note Linear (3 Blocks [ " - Tables
Dimension Items |Checker Painter Note }2} Auto Balloon /'V<We|d Symbol ! Datum Feature Centerline m Revision Cloud
: PatEem ﬂ Magnetic Line LI@ Hole Callout @ Datum Target . Area Hatch/Fill ;
Drawing | View Layout | Annotation | Sketch ‘ Markup‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format : : ; “ = E‘
|
<\ / o @ - N - m % IC Eilil::] Mirror Entities J@
Smart L . Trim Offset [Af . . Display/Delete
Dimension E e @ Entities Entities P[P Lisaistchusy Relations
SO L o I
Drawing | View Layout ‘ Annotation ‘ Ske’;& ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format E
l - I I
Abc
v B @ b b o« B
Spell Measure Markup Section Performance Compare  Check  DriveWorksXpress
Checker Properties Evaluation Documents Active Wizard
Document
Drawing ‘ View Layout ‘ Annotation ‘ Sketch‘ Markup | Evafuate | SOLIDWORKS Add-Ir|
1 - I e 1
@ A, ~
® @ % # T S T K = W0
CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS SOLIDWORKS
360 Motion Routing Simulation Toolbox Flow Plastics
Simulation
Drawing ‘ View Layout ‘ Annotation ‘ Sketch ' Markup ‘ Evaluate ‘ SOLIDW{)RKS Add-Ins ’mg
Edit
Sheet
Format
Drawing ‘ View Layout | Annotation ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format E
Ry
EL T AN . .
To add a custom tab, right-click on a tab and MBO-=: LR
: ; ¥ | Enable CommandManager
click Customize. You can also select to add a 9
. . v R
blank tab and populate it with custom tools from Use Large Buttons with Text
the Customize dialog box. Tai%
Todulhoars
Customize...
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SOLIDWORKS® 2022 Quick Start

The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it
based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for an Assembly document. Tabs will vary

depending on system setup and Add-ins.

B @ & B W P [/ B @ §
S Gk @ o g [ (e
Insert Mate Linear Smart Move Show Assembly Reference. New = Bill of Exploded Instant3D Update Take Large
Components Component Fasteners Component  Hidden Features Geometry Motion Materials ~ View SpeedPak  Snapshot Assembly
Pattern Components Study Subassemblies Settings
Assembly ‘ Layout  Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ /@ Q @ @M
g & S0-3 © @ 2S®P &
Create  Smart LY. = Convert Offset . Insert  Mate  Move Show
layout Dimension [E=) @ A Entities Oon Components Component  Hidden
. @ - @ Surface . @lnsen Block Components
Assembly | Layout | Sketch | Markup | Evaluate | SOLIDWORKS Add-Ins OO LELAE B O BB -

C ¢ /0O0nu-& O @
Sketch  Smart @< (\ . @ . A Convert Offset

Dimension Entities On

o @ o . Surface

(&

Rapid |Instant2D
Sketch

Assembly ‘ Layout ‘ Sketch | Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins

WY T T

Tl & W O e IO e b BB e B o

Design Interference Clearance  Hole ~Measure Markup Mass  Section Sensor Assembly Performance Curvature Symmetry Body ~ Compare  Check

5 7 ® & O

FloXpress D Costing
Study Detection Verification Alignment Properties Properties Visualization Evaluation Check  Compare Documents  Active Analysis Wizard  Analysis Wizard
uuuuuuu Wizard
Assembly‘Layout Sketch Markup Evaluate | SOLIDWORKS Add-Ins O 0 L200 5 G- 0 ’@M -
@ @ s o
@ @ % & E T < B
CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS SOLIDWORKS
360 Motion Routing Simulation Toolbox Flow Plastics
Simulation

Assembly ‘ Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘

w s

AR The Markup tab is displayed by default in the
CommandManager on some systems. You can
draw markups with a mouse on non-touch devices,

display bounding boxes for markups, create &
. . &
markups in drawings, and use the context toolbar to

Exit
access markup options. Ma%p
The Markup toolbar displays different options

Color Draw |Erase Select Touch Note

2& LK DK

/ 5{[’7 Assembly

Layout | Sketch ‘ Markup ‘ Evaluate ‘

depending on the device. Draw praw and Touch Touch
are not available for non-touch devices.
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Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere on or
outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -
Dock above | |, Dock left , Dock right

-~

and click the needed

2 3

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Collapse the CommandManager

Collapse the CommandManager to only display the available tabs.
No tools are shown.

Click the Collapsed CommandManager arrow to the right of the
active CommandManager tab as illustrated. Only the tabs are
displayed.

5

Enable CommandManage

@ CircuitWorks
G PhotoView 360

@O ScanTo3D

el

(? SOLIDWORKS Motion
:E SOLIDWORKS Routing
& SOLIDWORKS Simulati..,
? SOLIDWORKS Toolbox

EI TolAnalyst

£5 SOLIDWORKS Flow Si.

(e}

TP SOLIDWORKS Plastics

WSOLIDWORKSAdd-Ins ‘MBD Dimensions ‘Evaluate ‘Markup ‘Sketch ‘Features

To display the CommandManager tools back, click on a- @
a CommandManager tab. Click the Pin

X

@ -

CommandManager as illustrated.

0

Collapse CommandManager

2
DS SOLIDWORKS File Edit View Insert Tools Window @ D ~ 2‘7

Features ‘Sketch‘ Markup‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘
I

2 N
DS SOLIDWORKS File Edit View Insert Tools Window > @ - 2‘7 - - g -

50 B &

FeatE[es ‘ Sketch ‘ Markup | Evaluate ‘ MBD Dimensions | SOLIDWORKS Add-Ins ‘
%

Boss/Base Boss/Base Cut  Wizard Cut Pattern

3 fSwept Boss/Base Eé @ ﬁ Swept Cut @ EE @ Rib Wrap oﬁ U h\m

Extruded Revolved i Lofted Boss/Base Extruded Hole Revolved m Lofted Cut Fillet Linear E Draft @ Intersect zeference Curves Instant3D

eometry

@ Boundary Boss/Base @ Boundary Cut @ Shell i|':ﬂ Mirror

®@ ® - & X

Pin CommandManager
I
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Part FeatureManager Design Tree

The Part FeatureManager consists of various tabs:

o FeatureManager design tree & tab.

SOLIDWORKS® 2022 Quick Start

%E%%OWF@’
7

& Bracket (Default< <Default>_Display State 1>)
4 History

e PropertyManager tab.

o ConfigurationManager S tab.
e DimXpertManager D tab.

e DisplayManager @ tab.

o CAM FeatureManager tree \C tab.
o  (CAM Operation tree g. tab.

o CAM Tools tree ? tab.

(s &
4

Click the

CommandManager and FeatureManager tabs
and folder files will vary depending on your
SOLIDWORKS applications and Add-ins.

Select the Hide/Show FeatureManager Area tab

;EEE as illustrated to enlarge the Graphics window

for modeling.

w1

AR The Sensors tool
located in the FeatureManager
monitors selected properties in
a part or assembly and alerts
you when values deviate from
the specified limits. There are
five sensor types: Simulation
Data, Mass properties,
Dimensions, Measurement and
Costing Data.

%L direction arrows to expand or
collapse the FeatureManager design tree.

Sensors

-

-

[J Top Plane

I_.Origin

v

® Fillet1

v

EE LPattern1
3 @10.0 (10)

EE LPattern2

-

-

EE LPattern3

[Al Annotations

Solid Bodies(1)

§5 Material <not specified>
GJ Front Plane

[J Right Plane

@ Extrude-Thin1

(& @5.0 (5) Diameter Hole1

Diameter Hole1

Cut-Extrude1

[J Top Plane
Ej Right Plane
I_, Origin

B Fillet1

EE LPattern1

EE LPattern2

EE LPattern3

@ Extrude-Thin1 l
@ @5.0 (5) Diameter H ]
(& 210.0 (10) Diamete:

Cut-Extrude1

Hide FeatureManager Tree Area

= = [#
SER SR |8k eeF!
7 Sensor @
% FLATBAR (Default<<Default>_D v X M
Hist
i Sensor Type o>
Senspre 5 -
3 Ann( Addljguorm K Mass Properties hd
55 Mate Notifications... Properties A
7 Fron Rename tree item 7  IMass v
i Top Hide/Show Tree Items.. &
(J Righ Collapse Items
1, origi Customize Menu
Value : 0.0113609512 Ib
DAlert v
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Various commands provide the ability to
control what is displayed in the
FeatureManager design tree.

1. Show or Hide FeatureManager items.
w1
AR Click Options %~ from the Menu
bar. Click FeatureManager from the
System Options tab. Customize your
FeatureManager from the Hide/Show tree
Items dialog box.

2. Filter the FeatureManager design tree.
Enter information in the filter field. You
can filter by Type of features, Feature
names, Sketches, Folders, Mates, User-
defined tags and Custom properties.

w1

Bs Tags are keywords you can add to a SOLIDWORKS
document to make them easier to filter and to search. The
Tags & icon is located in the bottom right corner of the

GraphiCS WinOW. < @;.Zk(zt)c;:ameter Hole1
o ! - (_ Sketch3
”Q\ Collapse all items in the FeatureManager, right-click | C e _
;| X - [@210.0 (10) Diameter Hole1
and select Collapse items, or press the Shift + C keys. U Sketchs
The FeatureManager design tree and the Graphics window } Ccuts::::ﬂ
are dynamically linked. Select sketches, features, drawing U sketché

views, and construction geometry in either pane.

Split the FeatureManager design tree and either display
two FeatureManager instances, or combine the

FeatureManager design tree with the

ConfigurationManager or PropertyManager.
Move between the FeatureManager design tree,

PropertyManager, ConfigurationManager,

DimXpertManager, DisplayManager and others by

selecting the tab at the top of the menu.

Overview of SOLIDWORKS® and the User Interface

System Options - FeatureManager

Gsearch options

> o X

System Options Document Properties

.a\
h/f

[ scroll selected item into view

Chinese-simpliied

add timestamp to comments

tsin PropertyManager

Hide/show tree items

[ Blocks Automatic 5] Equations Show
(T3] Design Binder Automatic B Material Show
[&) annotations. Show W Default Planes Show
60 sold Bodies Rimae 1. orgin show
(@) Surface Bodies Automatic [& Mate References. Automatic
() Tables Automatic v 5k Design Table Automatic v
v
Reset.
oK Cancel Help

WBER e @
ketch X
% Bracket (Default<<Default>_Dis|

» [A] Annotations
~ @ Extrude-Thin1

/L,@a[;%ea97>
g

@ FLATBAR (Default< <Default: A
History
Sensors
» [A] Annotations
» [@]Solid Bodies(1)
= Equations
22014 Alloy v

< >
e
Ea

%2&6}@

urations

Split

~ @ FLATBAR Configuration(s) ([
» [ETables

[ « Default [ GIDS-SC-104
3HOLE [ GIDS-SC-100]

SHOLE [ GIDS-SC-100]

7HOLE [ GIDS-SC-100]
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The ConfigurationManager 2 tab is located to the

right of the PropertyManager tab. Use the
ConfigurationManager to create, select and view
multiple configurations of parts and assemblies.

The icons in the ConfigurationManager denote
whether the configuration was created manually or
with a design table.

The DimXpertManager D tab provides the ability to
insert dimensions and tolerances manually or
automatically. The options are: Auto Dimension

& - -
Scheme | Auto Pair Tolerance 3, Basic,
Location Dimension [l , Basic Size Dimension

N , General Proﬁle Tolerance e , Show
Tolerance Status %o , Copy Scheme % , Import

Scheme G}, TolAnalyst Study * Kl and Datum
Target

R

2 TolAnalyst is available in SOLIDWORKS
Premium.

Fly-out FeatureManager

The fly-out FeatureManager design tree provides the
ability to view and select items in the
PropertyManager and the FeatureManager design
tree at the same time.

Throughout the book, you will select commands and
command options from the drop-down menu, fly-
out FeatureManager, Context toolbar, or from a
SOLIDWORKS toolbar.
w1

* Another method for accessing a command is to
use the accelerator key. Accelerator keys are special
keystrokes, which activate the drop-down menu
options. Some commands in the menu bar and items
in the drop-down menus have an underlined
character.
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R © -

Cﬂ ConfigurationManagerl
- & FLATBAR Configuration(s) (Default)
» @ Tables
% « Default [ GIDS-SC-10009-9 ]
& 3HOLE [ GIDS-SC-10009-3 ]
& 5HOLE [ GIDS-SC-10009-5 ]
& 7HOLE [ GIDS-SC-10009-7 ]

SER S @

‘Qg = B DimXpertManager 'EI

NET
PES

&G PN Eg ¥

T ©raTend %b{
@\ﬂam
@ sensors
¥ Lpattern1 > [&l Anndftations
v X > [8]solid|Bodies(1
R .
Direction 1 N Equations
3
Edge<1> 36061 |Alloy
@ Front Plane
(® Spacing and instances I:j Top Rlane
O Up to reference Ij Right Plane
&Y 0.500in 1" B L origif
. — » @l Boss{Extrude1
o 3 ‘ = » |@ cut-Bxtrudes
Direction 2 v L prn
Features and Faces A
@é Cut-Extrude1 ‘ ]
@
[IBodies v
Instances to Skip v
Options A
Vary sketch
Geometry pattern
Propagate visual
properties
OrFull preview
@ Partial preview
Y
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show,
hide, and reorder tabs in the Task Pane. You can also set a tab as the default so it
appears when you open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:

3DEXPERIENCE Marketplace @ .

SOLIDWORKS Resources ﬁ

Design Library @ )
File Explorer B

View Palette .

Appearances, Scenes and Decals

Custom Properties .

w1

Ar Additional tabs are displayed with Add-Ins.

Use the Back and Forward buttons in the Design Library
tab and the Appearances, Scenes, and Decals tab of the
Task Pane to navigate in folders.

3DEXPERIENCE MARKETPLACE

Click the 3DEXPERIENCE MARKETPLACE @ icon
to connect to the 3DEXPERIENCE platform and leverage its
collaboration, product data and lifecycle management, organic
shape design, simulation solutions, and more. (Subscription

required.)

Use 3DEXPERIENCE MARKETPLACE to source 3D
content and services worldwide. (No license required.)

Overview of SOLIDWORKS® and the User Interface

M®EEITSE @

« Design Library co3 M
%
@ Q-GAEE 1
esign Library
V= annotations
> 7 assemblies
> = features
> & forming tools
V=7 motion
> P parts
> =rrouting
=7 smart components
F Toolbox
> &) SOLIDWORKS Content

M®EETSE@

3DEXPERIENCE

Extend
SOLIDWORKS
with the
3DEXPERIENCE
Platform

Erep e

®

0a0]|
11

Connect to the
3DEXPERIENCE®
platform and
leverage its
collaboration, product
data and lifecycle
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SOLIDWORKS Resources

The SOLIDWORKS Resources @ icon displays the following

default selections:

o  Welcome to SOLIDWORKS.
e SOLIDWORKS Tools.

e  Online Resources.

e Subscription Services.

SOLIDWORKS® 2022 Quick Start

& Welcome to SOLIDWORKS

SOLIDWORKS Tools
@ Property Tab Builder

® SOLIDWORKS Rx

@ Performance Benchmark Test

@ Compare My Score

4 Copy Settings Wizard
@ My Products

Online Resources

MeBNTe>e

@ 3DEXPERIENCE Marketplace

@ Partner Solutions

Subscription Services

Other user interfaces are available during the initial software
installation selection: Machine Design, Mold Design, Consumer
Products Design, etc.

Design Library
~

The Design Library @ contains reusable parts, assemblies, and
other elements including library features.

The Design Library tab contains default selections. Each default

goéple

Design Library

« e
@ ROES
v () Design Library
/= annotations
> = assemblies
> P features
> e forming tools
/= motion
> [ parts
> Brouting
= smart components
> U SOLIDWORKS Content

. i . ) e > § Toolbox
selection contains additional subcategories.

The default selections are: —

e Design Library.

° — ‘
S}OL[DWORKS COﬂt?l/ltd :E & ? EI & ?f.'z
(Internet access required). SOLIDWORKS SOLIDWORKS |SOLIDWORKS| TolAnalyst SOLIDWORKS SOLIDWORKS SOLIC

Routing Simulation Toolbox Flow Plastics
o Toolbox. Simulation
A N
s Q SOLIDWORKS Add-Ins ‘ <OLIDWORKS Toolb
oolbox

“¥* Activate the SOLIDWORKS
Toolbox. Click Tools, Add-Ins..,
from the Main menu. Check the
SOLIDWORKS Toolbox Library
and SOLIDWORKS Toolbox
Utilities box from the Add-ins
dialog box or click
SOLIDWORKS Toolbox from
the SOLIDWORKS Add-Ins tab.

Loads or unloads the SOLIDWORKS Toolbox add-in.
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Overview of SOLIDWORKS® and the User Interface

To access the Design Library folders in a non-network environment, click Add File Location

@ and browse to the needed path. Paths may vary depending on your SOLIDWORKS
version and window setup. In a network environment, contact your IT department for system

details.

File Explorer

File Explorer = duplicates Windows Explorer from your local
computer and displays:

e Recent Documents.

o Samples.

e Open in SOLIDWORKS
e Desktop.

View Palette

The View Palette tool located in the Task Pane provides the
ability to insert drawing views of an active document, or click the
Browse button to locate the desired document.

Click and drag the view from the View Palette into an active
drawing sheet to create a drawing view.
e

e The selected model is Bracket.

Appearances, Scenes, and Decals

Appearances, Scenes, and Decals e provide a simplified way
to display models in a photo-realistic setting using a library of
Appearances, Scenes, and Decals.

An appearance defines the visual properties of a model, including
color and texture. Appearances do not affect physical properties,
which are defined by materials.

Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model.
PhotoView 360 is an Add-in. Drag and drop a selected
appearance, scene or decal on a feature, surface, part or assembly.
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> @ OneDrive
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> ®This PC

> s Libraries

> Control Panel
> 3DPrintr

IR

I

« View Palette <o) M

EINEETD

I

Bracket
Options

O Import Annotations
Design Annotations

DimXpert Annotations

Include items from hidden features

3D View Annotations

Auto-start projected view

Drag views onto drawing sheet.

L B .

(A) Front (A) Top

(A) Left *Right

fppearances, Scenes, and .-Dl

oy
OAppearances(color)

> F@Plastic

> V@ Metal

> @ Painted

> F@Rubber
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V@ solid
> F@Lights

M®ETes@

> V@ Fabric
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> @Stone
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> ﬁ Scenes
> @ Decals

Default Appearance: color

T
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Custom Properties

The Custom Properties tool provides the ability to enter
custom and configuration specific properties directly into
SOLIDWORKS files.

Motion Study tab

Motion Studies are graphical simulations of motion for an
assembly. Access the MotionManager from the Motion Study
tab. The Motion Study tab is located in the bottom left corner of
the Graphics window.

Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.

SOLIDWORKS® 2022 Quick Start

« Custom Properties 552 &

Apply Reset

A property page for part files was
not found. Click 'Create now...' to
launch the Property Tab Builder.

If you already have a template,
place it in the folder specified in
Tools — Options — File Locations —
Custom Property Files.

Press F5 to refresh the page.

Hoese

’ Create now...

o]
11

>» = ¥ /] - -l BB 04 )

v L e e
A-&Gpar2 4

@Orie 0 :

» [HELigh
v L s

10 sec

|7 sec ‘ ‘Asec ‘ ‘95« |

Model | Motion Study 1 |

The MotionManager displays a timeline-based
interface and provides the following selections from the
drop-down menu as illustrated:

e Animation: Apply Animation to animate the
motion of an assembly. Add a motor and insert
positions of assembly components at various times
using set key points. Use the Animation option to
create animations for motion that do not require
accounting for mass or gravity.

e Basic Motion: Apply Basic Motion for
approximating the effects of motors, springs,
collisions and gravity on assemblies. Basic Motion
takes mass into account in calculating motion.
Basic Motion computation is relatively fast, so you
can use this for creating presentation animations
using physics-based simulations. Use the Basic
Motion option to create simulations of motion that
account for mass, collisions or gravity.
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w1

‘¥* If the Motion Study tab is not
displayed in the Graphics window,
click View > Toolbars >

MotionManager from the Menu bar.

Overview of SOLIDWORKS® and the User Interface

View_Jnsert Tools Window >

)

—~ = =2 —

V'S

Q Red raw\

Screen Capture

Display
Modify

Lights and Cameras
Hide / Show

Toolbars
Work%c!\
User Interface
Touch Mode

Full Screen

o &

[
L4

Customize Menu

Ctrl+R

F11

D¢

E Enable CommandManager

EY 2Dto 3D

B spwox

[ Align

V’A Annotation

@ Assembly

Blocks

2 configurations

U Curves

<L Dimensions/Relations

# Fastening Feature

E} Manage Printers

'@ MBD Dimension
Display States
Toolbox

Drawing

&' Explode Sketch

@ Features

8 Formatting
Layer

@1 Layout Tools

£ Line Format

Macro

Z Markup

Mold Tools

MotionManager

@ Qo

°@ Reference Geometry

@ Render Tools

==

Snaps
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3D Views tab

Only available in SOLIDWORKS MBD.
SOLIDWORKS MBD (Model Based
Definition) lets you create models without the
need for drawings giving you an integrated
manufacturing solution. MBD helps companies
define, organize, and publish 3D product and
manufacturing information (PMI), including
3D model data in industry standard file
formats.

Create 3D drawing views of your parts and
assemblies that contain the model settings
needed for review and manufacturing. This lets
users navigate back to those settings as they
evaluate the design.

SOLIDWORKS® 2022 Quick Start

Capture 3D View

Sort order:

History N

Update Previews

e

I:IIII!I:I Model | 3D Views | Motion Study 1

Use the tools in the MBD Dimensions CommandManager to set up your model with selected
configurations, including explodes and abbreviated views, annotations, display states, zoom
level, view orientation and section views. Capture those settings so that you and other users
can return to them at any time using the 3D view palette.

To access the 3D View palette, click the 3D Views tab at the bottom of the SOLIDWORKS
window or the SOLIDWORKS MBD tab in the CommandManager. The Capture 3D View
button opens the Capture 3D View PropertyManager, where you specify the 3D view name,
and the configuration, display state and annotation view to capture. See help for additional

information.

Dynamic Reference Visualization
(Parent/Child)

SER@

Y

Dynamic Reference Visualization provides the ability ‘% FLATBAR (Default<<Default>_Display
to view the parent/child relationships between items in | » [& History

the FeatureManager design tree. When you hover over Sensors

a feature with references in the FeatureManager design |, [ Annotations

tree, arrows display showing the relationships. If a
reference cannot be shown because a feature is not
expanded, the arrow points to the feature that contains
the reference and the actual reference appears in a text

box to the right of the arrow.

» [@Solid Bodies(1)
Equations
$382014 Alloy
lﬂ Front Plane
I Top Plane
[J Right Plane
I_. Origin

- ﬁ Boss-Extrude1
----------

Cut-Extiude

EE LPatterni

v
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Use Dynamic reference visualization for a part,

Viewserl Tools Window # @» o m o M.

assembly and mates. CA N cr Bownca @ BE B
. . . . . = BEEE NS m Lofted Cut Fillet Linear %Draﬂ l@

To display the Dynamic Reference Visualization, — : R
o CBroundaycut  ([Wshen B

click View » User Interface > Dynamic — e
Reference Visualization Parent/Child) from the Hide / Show

Main menu bar. Toolbars
Workspace . ]
User Interface » [¥] FeatureManager Tree Area
& TouchMode 29_Dynamic Reference Visualization (Parent)
Mouse Movements % Full Screen ‘\ o “’%“ Visualizaton (Chid)
o z‘ Tool
. . . Customize Menu —
A mouse typically has two buttons: a primary % e e
button (usually the left button) and a secondary B stars ar
button (usually the right button). Most mice also —onm e
include a scroll wheel between the _
buttons to help you scroll through - 2 '
documents and to Zoom in, Zoom out - 2
and rotate models in SOLIDWORKS. N 2
. . -3 — s
It is highly recommended that you use a g
mouse with at least a Primary, Scroll ===
and Secondary button. - /
Single—click (1) Primary button [ 2 Scroll wheel [ 3 Secondary button

To click an item, point to the item on

the screen, and then press and release the primary button (usually the left button). Clicking is
most often used to select (mark) an item or open a menu. This is sometimes called single-
clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than as one double-click. Double-clicking is most often used to open items on your desktop.
For example, you can start a program or open a folder by double-clicking its icon on the
desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).
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Summary

The SOLIDWORKS (Ul) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up
View toolbar.

975 SOLIDWORKS File Edit View Insert Tools Window »* ﬁ Ij
The Part CommandManager controls the QA P S svertsossmse 0
display of tabs: Features, Sketch, Evaluate, | exuded Revolved Extruded Revolved
MBD Dimensions and various poss/hase Bossffse o o
SOL[D WORKS Add—InS Features ‘ Sketch ‘ Evaluz‘lte ’ MBD Dim?nsions ‘ SOLID\;VORKS Add-Ins

The FeatureManager consists of various tabs:

@, S BER¢SNER,
o FeatureManager design tree ~V tab. = /
° ProperlyManager tab. &) Bracket (Default< <Default>_Display State 1>)

4 History

o ConfigurationManager S tab. [ sensors

[A] Annotations

Solid Bodies(1)

-

-

e DimXpertManager & tab.

§>5 Material <not specified>

e DisplayManager 6 tab. (J Front Plane

o CAM FeatureManager tree \| tab. g ;?gph: I;Z:e

o CAM Operation tree g. tab. , %ertizge_mn :
o  CAM Tools tree Eg tab. B Filet

-

(& @5.0 (5) Diameter Hole1
EE LPattern1

& @10.0 (10) Diameter Hole1
EE LPattern2

Cut-Extrude1

(e 3
4

Click the ﬂ direction arrows to expand or
collapse the FeatureManager design tree.

-

-

Bl
CommandManager and FeatureManager tabs and L&t LPattern3

file folders will vary depending on system set-up
and Add-ins.

You learned about creating a new SOLIDWORKS part and opening
an existing SOLIDWORKS part along with using the Rollback bar
to view the sketches and features.

Wl Overall drafting standard

A If you modify a document property from an Overall drafting | ANSI-MODIFIED
standard, a modify message is displayed as illustrated.

Derived from: ANSI
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w1
‘¥ Use the Search box, in the upper left corner of the Materials
dialog box, to search through the entire materials library.
. . Search...
Templates are part, drawing and assembly documents which S
include user-defined parameters. Open a new part, drawing or

assembly. Select a template for the new document.

In Chapter 2, establish a SOLIDWORKS session. Learn about
2D Sketching and 3D features.

Material

v [35] SOLIDWORKS Materials
v Steel

Create a new part. Create the Wheel for the Fly Wheel sub-
assembly.

Utilize the Fly Wheel sub-assembly in the final Stirling
Engine assembly.

Apply the following sketch and feature tools: Circle, Line
Centerline, Centerpoint Straight Slot, Mirror Entities,
Extruded Boss, Extruded Cut, Revolved Boss, Circular
Pattern, Hole Wizard and Fillet.

Incorporate design change into a part using proper design
intent, along with applying multiple geometric relations:
Coincident, Vertical, Horizontal, Tangent and Midpoint
and feature and sketch modifications.

Utilize the Material, Mass Properties, Appearance and
Measure tool on the Wheel.
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Notes:
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